Resume 101 Guide
 A resume is





a concise, organized summary of your skills, accomplishments, experiences, and
education, which is designed to capture the interest of a potential employer.
A resume should be tailored specifically for the kind of job/organization/career you are seeking. This
means you may have to write more than one resume if applying for different types of jobs.
The purpose of a resume is to secure an interview.
In writing a resume, “one size does not fit all.” Don’t try to make your resume look like everyone
else’s. For this reason, don’t use a resume template.
There are many different ways of constructing an effective resume, depending on the type of skills,
work experiences, accomplishments, activities, and so forth that you want to emphasize as being
related to your career/job preferences.

BEFORE Y OU CAN WRITE AN EFFECTIVE RESUME, you must first be able to identify your skills,
abilities, and interests and be able to relate them to the job/industry/career field in which you are seeking
employment.
If you are unsure about the types of jobs, industries, organizations, or careers you are targeting, make an
appointment with the Career Center to help you in developing some focus. Employers cannot (and will
not) decide what career is best for you; you must be able to communicate what skills and abilities you
have that fit the specific job or jobs they are trying to fill.

RESUME
TIPS

1. Be sure your resume
communicates your abilities, as
well as your personal qualities that
pertain to the job. These abilities
may have come from activities,
education, volunteer work, or from
work experience.
2. Focus on the employer’s
needs, not on your own needs.

6. Be consistent.
The order of information, spacing,
format, or highlighting should be
consistent throughout your resume.
7. Use action verbs in describing your
skills and experience.
Instead of…Responsible for assisting
with preparation of sales tax reports
each month
Write………Assisted in preparation of
monthly sales tax reports

3. Be concise.
Keep it simple and to the point.
An employer must be able to read Instead of…Was in charge of organizing
over your resume quickly (30 – 60 and taking care of spring rush activities
Write………Organized and directed
seconds)!
spring rush activities for over 50 new
4. Eliminate the first person
sorority pledges
pronoun “I” from your resume.
8. Write a draft of your resume, then
For example, “ I am seeking a
refine and polish it. Writing an effective
position in human services…”
resume takes some time and effort.
should read “Seeking position in
human services...”
9. Check your grammar and spelling!
Have at least one other person
5. Quantify your experience
proofread your resume before submitting
wherever possible. For example, it to an employer.
“Supervised others” can be made
more clear by stating “Supervised 10. Keep the resume to one page.
A resume should only be two pages if
three cash register attendants”.
you have a great deal of related
experience, activities, or training.
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Resume
RESUME FORMATS
CHRONOLOGICAL

 Use if your education and/or experience closely relates to your career goals
 Lists education and work experience in reverse chronological order (most recent information in each section first)
 Most commonly used resume format
FUNCTIONAL

 Puts greater emphasis on SKILLS and less on work history or educational background
 Effective when work experience does not show a direct relationship to the career goal or when there are
significant gaps in experience

COMBINATION

 Typically shows a short skills summary, while retaining the reverse chronological order on education and
experience sections

INTERNATIONAL RESUMES

Resume Do’s & Don’ts

 Each country has its own rules and standards for
writing resumes

 Please visit the Career Center Resource Library for
print resources when writing your international
resume

CURRICULUM VITAE

 Required for teaching/research positions in higher
education
 More detailed account of one’s background, and is
usually much longer than a resume

DO

 Use conservative font styles (Times New Roman,

SCANNABLE RESUMES
Many employers use electronic databases to store large
numbers of resumes. Resumes are scanned into a
database; the database can then be searched for
applicants that meet specific job requirements. If asked
for a “scannable resume,” follow these tips:
 Use “keywords” or phrases applicable to the career
field or related to the job sought.
 Use a standard font style sized between 10-14 points.
Avoid ornate fonts where the characters touch.
 Use boldface for emphasis, not italics or underlining.
 Use asterisks (*) instead of “bullets.”
 Do not double space between sections.
 The resume should be an original, printed on white or
light-colored paper. Do not fold or staple the resume.
For more information about scannable resumes, ask for
the “Going Digital: Plain Text and Scannable Resumes”
guide, available in the Career Center.






Arial, Arial Narrow, or similar styles). Font size may
range from 10-12.
Set page margins between 0.5 and 1.0 inches (top,
bottom, left and right).
Print your resume using a laser printer; white or offwhite bond paper is preferred. (Dark paper does not
copy or fax well!)
Keep your resume up to date, with correct addresses
and phone numbers!
ALWAYS include a cover letter when mailing your
resume to an employer.

DON’T

 Don’t make handwritten corrections.
 Don’t include: age, marital status, height/weight, birth
date, or a photograph.
 Don’t abbreviate (other than for the states - SC).
 Don’t exaggerate or lie on your resume. It will catch
up with you.
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What to Include
Your full name (in all capital letters and/or bold)
Complete address (list permanent and present addresses if in college)
Home and/or mobile phone numbers
E-mail address (Make sure your email address does not sound unprofessional.)

OBJECTIVE

The career objective tells an employer how you fit in the organization. It forces you
to focus on your job interest, and it unifies the rest of your resume. Three pieces of
information make up the objective:
1. The level or type of position (Example: entry level, sales trainee, social worker)
2. Where the job is located in the organization or industry (Example: international
news, marketing department)
3. Interests, knowledge, or skills you wish to share or hope to incorporate into your
work
Examples:
“To obtain an entry-level position in human resource management with particular
interests in wage and salary administration”
“Programmer position requiring knowledge of Visual Basic, C++, and JavaScript”
“Professional position in higher education utilizing skills in administration, program
development and counseling”
 Avoid double objectives: This can cause an employer to wonder if you really know
what you want. Use two separate resumes if you have more than one career
direction.
 Leave out phrases like “opportunity for advancement” or “challenging, rewarding
position.” These objectives only tell the company what you expect from them
(“What’s in it for me?”). Rather, tell the company what you are going to do for them.

EDUCATION

This section may contain the following: names and locations of schools or
programs; graduation date (or expected date); degrees, certificates, or licenses;
major; grade point average IF 3.0 or above; coursework related to the job you
want; awards or scholarships; and/or, study abroad experiences. These may
also be separate sections in your resume.

EXPERIENCE

Be sure that you cover full-time, part-time, internships, volunteer work, military
service, and self-employment. However, it is not necessary to list every job you’ve
ever had. If you have had a lot of work experience, limit the jobs you list to the
three or four you consider the most important as learning experiences. Include your
job title; employer name (company/organization); City/State; dates of
employment; and bulleted, active descriptions of your responsibilities and
major accomplishments.

ACTIVITIES, HONORS AND/OR SKILLS
You may want to mention interests and activities that abilities that
demonstrate job-related skills (leadership, organization, etc.); special abilities,
such as knowledge of computers or a foreign language; and/or honors
or awards earned. Do not include personal data, such as age and health status.
REFERENCES

Indicate that references are available but do not list them on your resume (use the
phrase “Available upon request”). Then list 3-5 references on a separate page that
is the same type of paper as your resume.
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Action Verbs

Remember to use the correct verb tense
Communication

Creative

Financial

Helping

Technical

Addressed
Arbitrated
Authored
Corresponded
Directed
Drafted
Edited
Enlisted
Expressed
Formulated
Influenced
Interpreted
Interviewed
Lectured
Mediated
Moderated
Negotiated
Persuaded
Presented
Promoted
Publicized

Acted
Arranged
Conceptualized
Created
Designed
Developed
Directed
Engineered
Established
Fashioned
Founded
Illustrated
Integrated
Introduced
Invented
Imagined
Modernized
Originated
Performed
Planned
Publicized
Revitalized

Accounted
Administered
Allocated
Analyzed
Appraised
Assessed
Audited
Balanced
Budgeted
Calculated
Computed
Developed
Downsized
Forecasted
Generated
Managed
Marketed
Planned
Projected
Researched
Secured

Advised
Assisted
Clarified
Coached
Counseled
Developed Rapport
Encouraged
Educated
Empathized
Established
Relationships
Expedited
Facilitated
Familiarized
Guided
Mentored
Referred
Rehabilitated
Represented
Supported
Supplied
Rectified

Assembled
Calculated
Catalogued
Computed
Designed
Detected
Devised
Engineered
Fabricated
Integrated
Maintained
Operated
Programmed
Remodeled
Revamped
Solved
Streamlined
Trained
Upgraded
Translated

Office Support

Research

Management

Teaching

Writing

Allocated
Approved
Arranged
Catalogued
Classified
Compiled
Dispatched
Executed
Formulated
Generated
Implemented
Inspected
Monitored
Operated
Organized
Prepared
Processed
Purchased
Recorded
Retrieved
Scheduled
Specified
Systematized
Tabulated
Validated

Analyzed
Assessed
Collected
Compared
Critiqued
Diagnosed
Documented
Dissected
Evaluated
Examined
Extracted
Hypothesized
Identified
Inspected
Interpreted
Interviewed
Investigated
Located
Measured
Observed
Questioned
Reviewed
Screened
Summarized
Surveyed
Synthesized
Systematized

Administered
Assigned
Attained
Authorized
Chaired
Contracted
Consolidated
Coordinated
Delegated
Developed
Directed
Evaluated
Executed
Improved
Increased
Instituted
Lead
Managed
Met goals
Organized
Oversaw
Planned
Prioritized
Produced
Recommended
Reviewed

Adapted
Advised
Clarified
Coached
Communicated
Coordinated
Demonstrated
Developed
Educated
Enabled
Encouraged
Evaluated
Explained
Facilitated
Guided
Informed
Initiated
Instructed
Motivated
Persuaded
Presented
Set goals
Stimulated

Addressed
Authored
Composed
Drafted
Edited
Formulated
Indited
Inscribed
Printed
Produced
Publicized
Recorded
Reproduced
Scribed
Scripted
Transcribed
Wrote
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Matthew Martinez
66 George Street, Charleston, SC 29424
843-953-5692 martinezm1@g.cofc.edu
EDUCATION
College of Charleston, Charleston, SC
Currently a freshman
Goose Creek High School, Goose Creek, SC
HS Diploma, May 2010
3.47 GPA
Enrolled in honors and advanced placement courses
EMPLOYMENT
College of Charleston Career Center
Career Center Assistant, August 2011 – Present
 Provide information and assistance to students, alumni, and the public
regarding Career Center services
 Assist with front office responsibilities and administrative duties
 Use Microsoft Word, PowerPoint and Excel to create documents and
presentations
Berkeley County Parks & Recreation
Camp Counselor, Summers 2008 – 2010
 Organized and supervised activities for children’s day camp
 Provided safe and fun environment for kids ages 5-10
LEADERSHIP & VOLUNTEER EXPERIENCE
Bonner Leaders Program, College of Charleston, 2011
 Selected to serve in a four-year, service-learning based campus leadership
program
 Work with local nonprofit to support the organizations mission and goals and
help with volunteer recruitment and retention
ACTIVITIES
Member, Students in Free Enterprise, College of Charleston, 2011
Writer, Goose Creek High School Yearbook, 2008-2010

Eliza Irmen

111 Main Street, Irmo, SC 29115
803.111.1111 irmenet@g.cofc.edu

OBJECTIVE
To obtain an internship in psychology, with particular interests in counseling children and
adolescents
EDUCATION
Bachelor of Arts in Psychology
Minor: Women’s and Gender Studies
College of Charleston, Charleston, SC

December 2014

GPA: 3.6
Relevant Coursework: Introduction to Psychology, Psychology of Gender
HS Diploma

May 2010

Irmo High School, Irmo, SC
GPA: 3.8
WORK EXPERIENCE

Office Assistant, College of Charleston Bookstore
August 2010 – Present
- Perform office duties efficiently and effectively, communicate with student customers,
and perform quarterly inventory
Cashier, Piggy Wiggly, Irmo, SC
March 2008 – May 2010
- Handled cash receipts and assisted customers in a professional manner
SKILLS & CERTIFICATIONS
Computer: Proficient in Microsoft Office programs; knowledgeable in Photoshop
Language: Conversant in Spanish
Certifications: Red Cross First Aid and CPR, 2007 – Present
ACTIVITIES & LEADERSHIP
Member, Psychology Club, College of Charleston
Captain, Debate Team, Columbia High School, Columbia, SC

2010 – Present
2009-2010

HONORS
Dean’s List

Spring 2011

JORDAN E. ANDRESEN
300 Jackson Street - Chicago, IL - (773) 555-5555 - andresenje@g.cofc.edu
OBJECTIVE

To obtain an internship at the Charleston Post and Courier to learn more
about the operations and management of a daily newspaper company

EDUCATION

College of Charleston, Charleston, SC
Currently a sophomore
GPA: 3.0

SKILLS

Journalism & Writing
 Served as Editor of high school newspaper
 Created a blog and forum to help inspire young people to begin writing
 Wrote articles on a variety of special topics posted on a daily blog
 Researched and wrote a weekly article about an ongoing project to
help make high school more environmentally friendly
 Displayed professional journalistic ethics at all times
Communications & Interpersonal Skills
 Created a multimedia presentation using slides, music, and narration
to brief newspaper reporters during orientation
 Spoke with potential newspaper advertisers and successfully met
advertising goals for the year
 Consulted and worked closely with newspaper’s faculty advisor
 Designed logo and branding for high school newspaper website
Leadership, Management & Organizational Skills
 Supervised ten high school newspaper reporters and contributors
 Managed newspaper staff’s daily activities
 Arranged client contracts for painting business
 Trained five new newspaper reporters and contributors

RELEVANT
ACTIVITIES

Member, Miscellany Literary Journal, College of Charleston, 2011-Present
Newspaper Editor, Northside High School, Chicago, IL, 2009-2010
Creator, Young People’s Writing Forum Blog, 2009-Present

WORK EXPERIENCE

Waiter, Gino’s East, Chicago, IL, August 2009-July 2010
Landscaper, Windy City Landscaping, Summers 2007-2010

HONORS

Outstanding Journalism Award, Northside High School, 2010
Honor Roll, Northside High School, 2007-2010

VERONICA E. DAVENPORT
66 George Street, Charleston SC 29424
davenportve@g.cofc.edu
(843) 805-5507
OBJECTIVE
To gain hands-on experience and understanding of industry practices through a Communications
internship
EDUCATION
College of Charleston, Charleston, SC
Bachelor of Arts in Communication, May 2015
Concentration: Communication Studies
Minor: Sociology
GPA: 3.6/4.0
Relevant Coursework:
 Interpersonal Communication, Sociology of the Family
WORK EXPERIENCE
Red Robin: Charleston, SC
Hostess, November 2009 - July 2011

Gained effective communication and interpersonal skills through efficient customer service

Assisted in creating an updated menu for the restaurant
Total Health Center: Mount Pleasant, SC
Receptionist, Summers 2008 – 2010

Greeted and assisted customers as they came and left the office

Proofread dictations and insurance reports

Re-structured and improved the office’s filing, scanning, and faxing procedures
SKILLS



Proficient in Microsoft Office and Adobe Photoshop
Certified in American Red Cross First Aid & CPR
ACTIVITIES




Member, Public Relations Student Society of America, College of Charleston, 2011 – Present
Member, College of Charleston Sociology/Psychology Club, 2011 – Present

E-mail Resume Tips
E-mail makes it possible for you to respond instantly to an opportunity, but if not
done correctly, your resume may be overlooked or deleted before it is read.
Whenever possible, copy a plain text (ASCII) resume into the body of your e-mail
message, rather than sending your resume as an attachment. Why?
 Attachments may contain viruses, particularly if they are in Microsoft Word.
 Firewalls may stop e-mail attachments from entering a company network.
 Recruiters may not take the time to open the attachment.
CREATE AN ASCII / PLAIN TEXT RESUME AND COVER LETTER
A text (or ASCII) resume will be stripped of formatting features such as bold and italics, so it may not appear very
attractive to you. However, it will be universally compatible with all systems. To convert your resume from MS
Word to plain text:
 Open your resume document, go to Edit > Select All and change the font to Courier 12 point; go to File >
Page Setup and change the left and right margins to 1.5 inches.
 Go to File > Save As > under “Save as Type,” select “Plain Text.”
 Select “yes” at the prompt that warns about features being compatible.
 Name and save this file, then reopen the file, which should now have a text (.txt) extension.
 Review and clean up your document:
- Insert space where necessary
- Left-justify all text
- Change bullets to asterisks or dashes
- Take out tabs and centering
- Change or remove symbols that didn’t convert properly
 Save your work!
TEST THE FILE
Open your text resume, copy and paste it into your email message box and send it to yourself and a few friends
to ensure that the text transfers properly.
CREATE THE E-MAIL MESSAGE
Follow the employers’ directions for applying to each position! Requirements and instructions will differ, based
on the individual company’s needs. If no specific instructions are given:
 Open your email program and set the message format to plain text, not HTML.
 Make the message Subject memorable! ‘My resume” isn’t going to grab the attention of busy person. Make
the subject line relevant, and include your name, e.g. “Resume of Jane Smith – Copy Editor position.”
 Now create a “cover letter” message just as you would in print, except leave off your mailing address, the
date, and the recipient’s mailing address. The message will begin with the salutation, e.g.: “Dear Mr.
Jones:”
 Type your “signature” at the bottom of your “cover letter”. Avoid clever quotations/sayings in your email
signature.
 After your signature, add a couple of blank lines and the text notation.
====================Resume Text Below=======================

 Add a couple more blank lines, then paste the text from your ASCII resume into the body of the email
message.
- Unless the employer has requested no attachments, attach your resume (in Word or PDF
format). This will accommodate employers who prefer a traditional resume. It doesn’t hurt to
send your resume in both formats!
Tip: When posting a resume to an online resume builder,
use your ASCII resume, and cut and paste it to fill the online form.
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Resume Planning Worksheet - Traditional Resume
Identifying information:
first name, middle initial, last name
current address, telephone number, e-mail address
permanent address, telephone number, e-mail address
OBJECTIVE
A (An) x position utilizing my x, y, and z skills OR A position in x that would benefit from my x and y experience

EDUCATION
college, city, state
degree, month, year to be received
major(s), minor(s), concentration(s)
grade point average (if above a 3.0)
related course work (maximum of 6 classes; only if applicable to objective)

EXPERIENCE (volunteer or paid. List most recent experience first.)
title, name of organization, city, state, and dates of employment
leading with an action verb, describe what you did at the organization
describe another responsibility or duty
describe another responsibility or duty
describe another responsibility or duty
(over)
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title, name of organization, city, state, and dates of employment
leading with an action verb, describe what you did at the organization
describe another responsibility or duty
describe another responsibility or duty

title, name of organization, city, state, and dates of employment
leading with an action verb, describe what you did at the organization
describe another responsibility or duty
describe another responsibility or duty
SKILLS (specify computer languages or special skills, including working knowledge, proficiency, or fluency
in languages other than English)

ACTIVITIES (list leadership positions, memberships or affiliations)
name of organization, title or position (if applicable)
name of organization, title or position (if applicable)
name of organization, title or position (if applicable)
HONORS AND AWARDS (if listing awards, tell the employer what the award was for)
name of honor or award, date received
name of honor or award, date received
name of honor or award, date received
REFERENCES

Available upon request
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